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Course Description
QAD designed this course to cover the basics of using the QAD Enterprise Applications Standard 
Edition (SE) and Enterprise Edition using the .NET UI.

The course includes:
• An introduction to the QAD .NET UI.
• Navigating the .NET UI.
• Application help options.
• .NET UI programs
• Basics of Browses

Students will also learn by labs designed to reinforce concepts presented in this training guide.

Objective

Learn how to navigate both the Enterprise (EE) and Standard (SE) editions of QAD Enterprise 
Applications. In addition, students will be able understand the help options, different programs and 
be able to use browses effectively.

Benefits

Students will become more efficient in the use of QAD Enterprise Applications.

Audience
• Implementation consultants
• Members of implementation teams
• Key users

Prerequisites
• Some familiarity with Enterprise (EE) and Standard (SE) editions of QAD Enterprise 

Applications

Course Credit and Scheduling

This course is designed to be taught in two days.

Virtual Environment Information 

The hands-on exercises in this book should be used with the “Standard Edition r01 - Training” 
environment, in the “Training” workspace.
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QAD Resources
If you encounter questions or problems on QAD software that are not addressed in this book, 
several resources are available.

Product Help

All QAD products ship with integrated help systems. including Character UI Help, .NET UI Help, 
QAD Assist, and QAD Guide Me help. In addition QAD has extensive Web Resources

The QAD website provides product and company overviews. 
http://www.qad.com/

From QAD’s main site, you can access QAD’s Learning or Support sites.

QAD Learning Portal for Training Opportunities

To view available training courses, locations, and materials, use the QAD Learning Portal. Choose 
Learning under the Global Services tab to access this resource. 

QAD Support for Product Documentation and the QAD Knowledgebase

To access release notes, user guides, installation and conversion guides by product and release, 
visit the Support website. Support als2o offers an array of tools depending on your company’s 
maintenance agreement with QAD. These include the Knowledgebase and direct links to QAD 
Support experts.

Choose Support under the Global Services tab. 

Any QAD customer can register for a QAD web account by accessing the Support web site and 
clicking the Accounts link at the top of the screen. Your customer ID number is required. Access to 
certain areas is dependent on the type of agreement you have with QAD.
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Objective

QAD Proprietary NET_INTR_020

Chapter Objective
Students will introduced to the following in the 
QAD .NET UI:
– The different types of UI mode in QAD 

Enterprise Applications
– Attributes of component-based and non-

component based programs
– The QAD .NET UI Login window
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Benefits

QAD Proprietary NET_INTR_030

Chapter Benefits
Students will understand the following in the 
QAD .NET UI:
– The different UI modes available in QAD 

Applications
– The different attributes of component-based 

and non-component based screens
– How to log in to the QAD .NET UI
 



8 Training Guide — QAD .NET UI
Training Flow

QAD Proprietary NET_INTR_040

Training Flow

Introduction
Navigation
Application Help
Programs
Browses
Character 
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Introduction

QAD Proprietary NET_INTR_050

Introduction
The QAD .NET UI
– Microsoft Technology

• Incorporates familiar UI features
• Reduces learning effort by users

– One interface, two modes
• QAD .NET UI
• Terminal Mode (rendering of Character UI)
 



10 Training Guide — QAD .NET UI
Character UI

Unlike the QAD .NET user interface, the character user interface depends completely on input 
from the keyboard. Because it is not a graphical user interface, all navigation is based on:

• A command-prompt interface to execute programs
• Combinations of keystrokes to issue commands within programs
• Navigation without use of a mouse through the UNIX character interface.

Component-based functions are accessible only through the QAD .NET UI. You cannot access any 
of these functions from the Character UI.

QAD Proprietary NET_INTR_060

Character UI
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Terminal Mode in the QAD .NET UI

With the QAD .NET UI interface, you can still use non-component based programs in a CHUI 
interface. You do this by selecting Terminal Mode in the Program Properties option. This is 
described in the section on Programs.

QAD Proprietary NET_INTR_070

Terminal Mode in the QAD .NET UI
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Attributes of Component-Based Programs

QAD Proprietary NET_INTR_090

Attributes of Component-Based Screens
Underlying Microsoft.NET Technology
Traditional Windows screen navigation
Familiar click and point functions
Right-click options
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Component-Based QAD .NET UI Screen

You use traditional mouse-clicks, tabs, and keyboard tabbing to navigate the component-based 
screen. 

QAD Proprietary NET_INTR_090

Component-Based Screen
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Attributes of Non-Component Based Screens

Non-component based screens are based on traditional procedural-written Progress-based 
technology. 

QAD Proprietary NET_INTR_100

Attributes of Non-Component Based Screens
A rendering of the Character UI for the .NET UI
Similar tabbing and keyboard navigation
Screen navigation bar for some non-component 
based screens
– Enabled in Tools|Options
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Non-Component Based QAD .NET UI Screen

All Standard and Enterprise Edition programs are non-component based, except QAD Enterprise 
Financials.

QAD Proprietary NET_INTR_110

Non-Component Based Screen
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Login Menu

Starting the QAD .NET UI

To launch the client, select the QAD Applications icon or Menu item under Programs on the Start 
Menu. Enter your assigned user and password if assigned. Select a system environment for which 
you have permissions from the drop-down menu.

QAD Proprietary NET_INTR_120

Login Menu
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Summary

QAD Proprietary NET_INTR_130

Chapter Summary
There are different types of UI mode within the 
QAD .NET UI
Component and non-component based screens 
have different visual and navigation attributes
You launch the QAD .NET UI from a menu 
option or desktop icon and select an 
environment from the drop-down menu
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Exercise and Knowledge Check

1 You can use the mouse for certain functions in Terminal Mode. (T/F)

2 Some component-based functions are configurable in Terminal Mode. (T/F)

3 Which of the two interfaces depends completely on input from the keyboard?

4 Which Enterprise Edition application is component based?
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Navigating the QAD .NET UI
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Objective

QAD Proprietary .NET_NAV_020

Chapter Objectives
Learn about the different ways of navigating in 
the QAD .NET UI.
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Benefits

QAD Proprietary NET_NAV_030

Chapter Benefits
You will be able to navigate the different types 
of screens and programs within Enterprise 
Applications.
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Training Flow

QAD Proprietary NET_NAV_040

Training Flow

Introduction
Navigation
Application Help
Program Types
Browses
Character UI
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Workspace Screen

Workspace Screen
• Main menu bar. Includes file, edit, tools, workspace, window and help.
• Menu search. Locates screens. 
• Application area. Displays the applications that are available in the QAD .NET UI.
• Favorites area. Lists fequently used screens.
• Quick search area. Search for a value across all of the fields in the browse.
• Browse Groups. Creates groups of browses for quick search purposes.

QAD Proprietary NET_NAV_050

Workspace Screen

Menu search for programs, 
browses, and other menu items

Applications Area

Favorites Area

Quick Search Field

Browse Groups

Main menu bar
 



24 Training Guide — QAD .NET UI
File Menu

The File menu commands include:
• Logoff/Login. Log off from all applications running in the QAD .NETUI. You can login as a 

separate user is security allows.
• Page Setup. Defines print output for browses. This has no impact on maitenace programs
• Print Preview. Generates a print preview of a browse prior to print.
• Print. Open the print dialog so that you can print the data for a browse or the screen for other 

programs.
• Program History. The section below Print displays the last six programs that you have opened. 

You can choose to open one of these programs directly from this pull-down menu.
• Exit. Close the QAD NET UI and log off any open applications.

QAD Proprietary NET_NAV_060

File Menu
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Edit Menu

The Edit menu commands include:
• Cut, Copy, and Paste. These are standard Microsoft commands. View associated shortcuts on 

the screen above.
• Menu Search. While In any screen you can immediately go to Menus search by using the 

shortcut Ctrl + M or select menu search.

QAD Proprietary NET_NAV_070

Edit Menu
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Tools Menu

• Options. View administrative information and set personal options for browses and other 
application settings. For more information, see next slide Settings the user cannot configure 
are viewable from Help|View Configuration.

• Internet Properties. Update the same settings that display when you select Internet Options 
from the Tools menu in Internet Explorer.

• Delete History. Delete the following data Temporary files: Internet Explorer cache and IE 
cookies, and cached resources created for the current configuration.Session information: the 
graphical state stored by the GUI persistence manager. Also deletes user input, such as last 
configuration, last workspace, most recently used menu items, and credentials. 

• Manage Workspaces. Activate and deactivate workspaces from a list and reorder them.
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Tools Menu
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Tools|Options

Field Descriptions

• Cancel transaction on drill change. On a maintenance screen, you can then use the up and 
down arrows on the keyboard to select next item from an attached look-up browse. If trues the 
capability is true if false then the next item will not populate.

• Cell Font. Specify standard windows font name, style, and size to use for cell data values. 
• Link Font Color. Choose the color to use for hot-linked data values. You can choose system 

colors, Web colors, or custom colors from a color palette
• Row Alternating Color. Specify the background color for every other row in the browse 

display.
• Row Background Color. Specify the background color for data rows in browses.
• Rows Per Page. Specify the number of data rows to retrieve for each browse page of data in 

the browse. The default is 100.
• Desktop Auto advance on next data field. Specify whether to go to the next frame after leaving 

the last field in the current frame.
• Cell Font. Specify the font name, style, and size to use for cell data values. This field displays 

a standard Windows font dialog where you can select a font, font style such as bold or italic, 
and font size.
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• Prompt user on open transaction. When you close a program that has a transaction running, 
you can have the QAD NET UI prompt you to double-check whether you want to close the 
program.

• Screen Navigation Bar. To help you navigate complex screens, the QAD NET UI includes a 
navigation tool for selected programs. This option specifies whether to include the screen 
navigation bar when displaying selected programs.

• Text Report Font. Specify the font in which reports are displayed when output to text.
• UI Extensions. Specify whether to include additional UI extensions such as enhanced button 

labels.
• General Allow Multiple Applications. Specify whether you can launch multiple instances of 

the QAD NET UI.
• Left Navigation Panel Style. Specify the appearance of the left navigation panel, which 

includes the Applications Pane, Favorites Pane, and Role Menu Pane. .
• Enable Home Page. Specify whether the home page displays in the Home Page tab when you 

log in.
• Internet Properties. Update the same settings that display when you select Internet Options 

from the Tools menu in Internet Explorer. 
• Delete History. Delete temporary files, session information, user preferences, and log file data.
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Workspace Menu

Manage Workspaces. Activate and deactivate workspaces from a list
• A workspace typically represents a domain. When you exit the QAD NET UI, the active 

workspace is saved and displays when you log in again.This allows you to change domains by 
selecting from the list. The check mark signifies the domain that is currently active. You can 
also change your workspace from the Workspace Selector along the bottom of the QAD NET 
UI window. In The SE edition you login to the default domain as defined in user maintenance.

QAD Proprietary NET_NAV_100

Workspace Menu
 



30 Training Guide — QAD .NET UI
Window Menu

This menu displays the programs in the order in which they were opened. Close all windows shuts 
all screens on the workspace.
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Help Menu

Use the Help menu to display Application and Program Help, and to view installation and 
application configuration details.

The Help menu commands include:

Search. This option displays the QAD Assist default search page.

Application Help. This option is available when your cursor is placed within a non-component 
based field or screen. When you then select Application Help, field or procedure help is 
displayed for the field or screen.

View Configuration. Opens a window that displays various configuration settings that cannot 
be directly changed by a user of the QAD .NET UI. These settings must be changed by a 
system administrator.

About. Display information about the version of QAD .NET UI that is running, the time the 
QAD .NET UI was started, and the total amount of physical memory the QAD .NET UI is 
using. (If N/A is displayed, the operating system is not giving the QAD .NET UI permission to 
access system information.)
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Applications Area

The Applications area displays the menu items for the QAD applications running in the QAD NET 
UI. When the system is installed, the default menu organization is automatically loaded. Multiple 
screens can be open at any one time Menu Search

• Find programs based on one or more menu label keywords, program name, or menu number. 
For example, enter sales to display all menu labels that include the word sales.

• Execute a specific program based on full menu label, program name, or menu number. For 
example, enter Item Master Maintenance, ppptmt.p, or 1.4.1 and then press Enter to display 
Item Master Maintenance. 

• Execute a specific program based on a shortcut defined in the Name field of Menu System 
Maintenance. 

• When typing in the menu search area different sceens appear as the typing continues untill the 
proper screen is located. This is called predictive text.
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Double click on any 
program to open

Click folders to open
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Program Properties

The Properties window includes two tabs, General and Program.
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Properties

Right-click any 
program and 
select properties
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Properties Options

General:
• URL. The QAD Shell URL for the program.
• Key. The program number. For example, 7.1.1 is the program number for Sales Order 

Maintenance.
• Aliases. The program number and name. For example, for Sales Order Maintenance, 7.1.1 is 

the program number and sosomt.p is the program name.
• Menu. The menu item folder location.

Program:
• Domain. The current working domain and domain currency. If the specific program updates 

data that applies to all domains.
• Program. The program name. For example, sosomt.p is the program name for Sales Order 

Maintenance.
• UI Template. If the user executing the program has been assigned a Configurable Screens 

version of the program, the name of the assigned UI template displays.
• Desktop Version. Version details for Desktop.
• Version. Product system version details.
• Open with. Desktop or Terminal.
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Select Terminal

Program 
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Number
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Program Screen in Terminal Mode

.
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Program Screen in Desktop (UI) Mode

Here we contrast the QAD .NET UI with the more traditional Terminal version in the prior screen. 
Use point and click, tab, Next, Back or Header, Lines and Trailer Tab to navigate in the non-
component based QAD.NET UI.
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Favorites
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Favorites

Programs that are 
used frequently so 
that a search is not 
required

Right-click a 
program and select 
Add to Favorites, or 
drag and drop 
programs to the 
Favorites area
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Switching Domains

With the workspace selector toolbar along the bottom of the screen, you can quickly change 
workspaces and domains.
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Horizontal and Vertical View Tab Groups

Horizontal and Vertical Tab Groups. There are two methods or views of making multiple screens 
appear on the desktop. This works especially well with the .NET UI browse programs.

QAD Proprietary NET_NAV_200

Horizontal and Vertical Tab Groups
 



40 Training Guide — QAD .NET UI
Component and Non-Component Based Programs

Only Enterprise Edition Financials and some System Administration programs are component-
based. All other applications are non-component based, including Standard Edition Financials. 
Component-based programs have individual maintenance programs, such as Create, Modify, and 
Delete.
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Component and Non-Component Based Programs

Enterprise Financials and System 
Administration programs only

All other programs are
non-component based
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Navigating Component-Based Screens

Because the component-based UI is based on Microsoft .NET technology, it incorporates familiar 
mouse, click and drag, and tabbing functions.
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Navigating Non-Component Based Screens

Because non-component based screens are a rendering of the character UI, you can navigate these 
screens using the same keyboard commands. You can also use mouse clicks to select fields and 
enter data.

If the program opens in .NET UI mode, a navigation bar is displayed along the top of the screen 
indicating where you are as you proceed through the program screens. For example, the screen for 
Purchase Order Maintenance includes a navigation bar indicating the parts of a purchase order: 
Header, Tax Info, Lines, and Trailer.

The Screen Navigation Bar option in the Desktop section of the Options menu (choose Tools|
Options) specifies whether your QAD .NET UI client displays the navigation tool.
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Navigating Browses
Fie

Many fields display a small magnifying glass icon. This indicates that a lookup is associated with 
the field. Click the icon or use the Alt+L keyboard shortcut to display the lookup. The lookup lists 
valid values for the field.

A drop-down list is displayed when only a few values apply to a field.
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Navigating Process Maps

Processes, or process maps, are graphical models of workflows that link to programs, browses, and 
other process maps using advanced features of .NET technology. 

Process map nodes provide drill-down navigation to individual programs within process flows.
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Navigating Process Maps
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Drill-Down and Breadcrumbs

Processes are built with two basic components:
• Nodes are represented by various shapes and typically indicate a step within the process.
• Connectors are lines with arrows that indicate the direction of execution for the steps (nodes) 

within the process.

You navigate the process map using nodes, and can re-trace your steps using the hyperlinked 
breadcrumbs at the top of the screen.
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Summary
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Summary
You can display some non-component based 
programs in terminal or .NET UI mode
Component-based programs display in .NET UI 
mode only
A screen navigation bar is available for some 
programs
Process maps let you drill-down on process 
flows
  



Navigating the QAD .NET UI 47
Exercise and Knowledge Check

1 The Screen Navigation Bar for non-component based programs is enabled in which menu 
option?

2 How do you navigate between domains?

3 Which is the only component-based application in QAD Enterprise Applications?

4 How do you display the program linked to a process map node?

5 Open up a Sales Order Menu screen by navigating through the folders. Which three folders did 
you open to get to the Sales Order Maintenance screen?

6 Open up Purchase Order Maintenance Screen using the menu search.

7 Open up Sales Order Browse by entering sobr009.p in the menu search field. What is the 
screen number?

8 Open up Sales Order Maintenance in terminal mode.

9 Display the lookup browse for the first field of Purchase Order Maintenance. What is the name 
of the master file used or name of the browse?
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Objective
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Objective
Introduce the student to the extensive help 
capabilities of the QAD .NET UI. 
– Character UI Help
– QAD .NET UI Help
– QAD Assist
– QAD Guide Me
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Benefits
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Benefits
You will be aware of the different types of help 
and how it can be accessed. 
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Training Flow
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Training Flow

Introduction
Navigation
Application Help
Program Types
Browses
Character Version 
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Help in Terminal Mode

Help
• The first time you press F2, a lookup browse displays if one is attached. If not, field help 

displays first. Use lookup browses to view records available to specified fields. You can 
choose a record to enter in the field. If you enter a value and press Enter, the list in the bottom 
of the browse frame scrolls to the first record that matches that value. Use the arrow keys to 
scroll through the list, then select the record by pressing Enter.

• Press F2 again to display field help. It describes a specific field and how it is used in the 
program. Most updateable fields have field help. Display-only fields do not.

• Press F2 again to display procedure help. It describes the program and how it is used in the 
module. Procedure help is not generally provided for reports, inquiries, browses, or control 
programs.
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Help in Terminal Mode
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Help Menu

Help

• Search. The Assistance Panel is available by selecting Search.
• Application Help. This option is available when your cursor is placed within a non-component 

based field or screen. When you then select Application Help, field or procedure help is 
displayed for the field or screen.

• View Configuration. Opens a window that displays various configuration settings that cannot 
be directly changed by a user of the QAD .NET UI. These settings must be changed by a 
system administrator.

• About. Display information about the version of QAD .NET UI that is running, the time the 
QAD .NET UI was started, and the total amount of physical memory the QAD .NET UI is 
using. 
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Help Menu
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Non-Component Program and Field Help

Press F1 or select menu bar help and program help will appear on the top of the page and field help 
on the bottom.
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Non-Component Based Program and Field Help
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Component Based Help

When you select help within a component-based screen, the system displays a context-sensitive 
help topic for that screen within the QAD Assistance Panel.
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QAD Guide Me

The QAD Guide Me feature provides immediate mouse-over descriptions of fields in both 
component and non-component programs. The feature is disabled by default.

Note   Field help for non-component based programs is also displayed by pressing the F1 key 
when the cursor is positioned in the field. Click the More... link to display an extended description 
of the field, and the Edit link to edit this description in Field Help Maintenance. 

Note   The Edit option is only visible for users who have access to Field Help Maintenance.

QAD Proprietary NET_HELP_080

QAD Guide Me
 



58 Training Guide — QAD .NET UI
QAD Assist Panel

QAD Assist Panel

The QAD Assistance Panel provides online Help for the .NET UI and for Enterprise Edition 
applications. Assistance replaces the previous .NET UI and application online help files, and is a 
searchable HTML interface that is displayed by pressing the F1 key. The panel can also be 
accessed by selecting the option in the Help menu. The Panel features links to program help, field 
help, user guides, and process maps. You can display results for the search entry in any of these 
formats or in all of them. 
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QAD Assist

Single Terms and Phrases

You can search for single terms (such as ‘Test’), phrases (such as ‘Work Orders’) or complex terms 
using operators (such as ‘test AND system’). The panel stores default fields, which you define dur-
ing deployment, which do not need to be specified when searching. The following operators are 
supported by the panel:

AND, +, OR, NOT, -
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Summary
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Chapter Summary
Program and field help is available for both 
component- and non-component based 
applications. 
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Exercise and Knowledge Check

1 Launch Purchase Order Maintenance in terminal mode. 
Press F1 in the first field of the purchase order.? What is displayed? Press F1 again. What is 
displayed this time? 

2 Go to the Sales Order Maintenance screen and select Help|Search. What screen is displayed? 

3 Do a search on the word Sales. Drill down on Sales analysis. What is displayed?

4 Go to Journal Entry Create and hit F1. What is displayed? Note the differences between a non-
component based help and component based help.
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Programs in the QAD .NET UI
  



Programs in the QAD .NET UI 65
Objective

QAD Proprietary NET_PRG_020

Chapter Objectives
The objective of this chapter is to describe 
program types and program features in QAD 
Enterprise Applications.
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Benefits
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Benefits
You will be able to identify different program 
types and will be familiar with some basic 
Enterprise Applications program features.
  



Programs in the QAD .NET UI 67
Training Flow
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Training Flow

Introduction
Navigation
Application Help
Program Types
Browses
Character Version 
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Program Types

QAD Proprietary NET-PRG-050

Program Types
Maintenance Programs
Inquiry and Report programs
Browse Programs
Transaction Programs
Utility Programs and Control programs
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Maintenance Programs

The Item Master Maintenance and GL Account Create Entry are examples of maintenance 
programs that update the database directly when the record is entered and saved.

In the case of non-component maintenance programs changes to the record will be made in the 
same maintenance screen, where as in component based maintenance programs changes are made 
in the Create, Modify, or Delete maintenance screens.
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Inquiry and Report Programs

Inquiries and reports retrieve and display operational database records. Inquiries are primarily 
used to answer specific questions. Reports usually provide more detail and are printed for a range 
of data records. You select data by entering a specific range of criteria, such as item number or 
date.

Typically, inquiries are viewed online and reports are sent to a printer or file. However, you can 
also print inquiries and view reports. In addition, other output options, such as e-mail, are 
available. 
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Component-Based Report 

Component-based reports have multiple output options, including viewer, printer, and export to 
PDF, XLS, and DOC standards. The report output is easy to customize, and you can create an 
extensive set of reports with unlimited report variants for many output types. 

You can run a report immediately, or choose to schedule it to run later. In this case, a pop-up 
window opens to let you enter details for running the report at a later date. 
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Transaction Programs

Transactions programs control and record activities related to business documents such as sales 
orders and invoices. An example of a transaction is receipt of a shipment for a purchase order 
using Purchase Order Receipts or Returns. Enterprise Financials transactions programs include 
Customer and Supplier Invoice, and Journal Entry.

Most data in the database is transaction data. Every day, sales orders come in, purchase orders go 
out, and work orders make demands on and create material for inventory. These events result in 
transactions, which are stored in transaction tables. In contrast to control programs, transaction 
tables are constantly updated by users of the system.
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Control Programs

Control Data

When you implement a module, you enter data that the system uses later to control how the system 
interacts with users and with the database. This data is stored in control tables. Control tables 
enable you to adapt the system to your environment. The data and settings in these tables 
determine how certain programs are displayed, the numbers assigned to transactions, the GL 
accounts for particular transactions, and so on. When you can manage a typical manufacturing 
function in more than one way, control programs let you establish a preference.
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GoTo Function

The GoTo menu for non-component based programs such as Sales Order Maintenance displays the 
Add Link option. Use Add Link to create links to other programs using User Tool Maintenance 
(36.20.4). The links you add display on the Program Links drop-down 

The GoTo option for component-based programs displays GoTo options and Related Views. 
Related Views are commonly used views and reports that apply to the record you are currently 
working with.

Go To behaves differently depending on whether the current field has data in it:
• If the field has a value, Go To invokes the View activity.
• If the field is blank, Go To invokes the Create activity.

All of the related views take the record you are currently using as the base for the information.You 
can simply click the GoTo to see the Create New Budget Group or Create New GL Account Unit 
of Measure. 
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GoTo for Non-Component and Component-
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Messaging

The QAD .NET UI includes a messaging capability so that you can send messages and workflow 
information to other users of the system. When using programs, browses, inquiries, and process 
maps, you have an Inbox on the Right side of the application area for sending and receiving 
messages. You can also send program or browse workflow messages, which include links to 
programs or browses, by choosing Actions|Workflow when using a program or browse

To Send a Message

• Click the Compose Message icon. 
• In the To field, enter the user IDs or names of the users to whom you want to send the 

message.
• In the Subject field, enter text indicating the subject of the message. 
• In the content area, enter or paste message content. 
• Click Send to send the message (or click Cancel to cancel it). 
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Workflow

Workflow is available for both types of program and is visible as an Actions menu option for non-
component based programs and as a Tools menu option for component-based programs. When you 
click Workflow in a non-component based program, the system creates an e-mail message for 
another system user, with the current screen as an attached link. This e-mail is then posted to the 
user’s Inbox. 

In a component-based program, you use the Workflow object dialog to specify the name of the 
workflow, the role of the recipient and activity they are required to perform on the link.
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Workflow
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Copy

The Copy menu is only available for non-component based programs and lets you to copy the text 
of the current screen to the clipboard, or copy an image of the current screen to the clipboard.
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Print

The Print menu is common to both types of program and prints the current screen to the default 
printer.
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Attach

Attach lets you attach any type of document—such as a Microsoft Word file, graphics file, or 
PDF—to a record within the application. This integration ensures that all required documentation 
is immediately accessible when needed. You can attach and view any type of file if the 
corresponding viewing software is available on the client. This is both applicable to component 
and non-component based programs.
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Record Program Actions

The Program Export File function is a test utility in the QAD .NET UI and is available in the 
Actions menu for all non-component based programs. This function lets you record your actions as 
you complete an application process and save the recorded actions to an .XML or .XLS file that 
you store locally. You then execute the saved .XML or .XLS file in the Execute Document Import 
function to reproduce the recorded process on screen. Saved files can be exported for testing to 
another QAD .NET UI environment, or imported into the current environment. 

1 Launch a program.

2 Choose Actions|Export Data. An Export Data screen is displayed (minimized) on the screen 
while the system is recording your user actions. Each user action is immediately listed in the 
Actions grid of this screen, and you can pause, name, and save the recording in this dialog

3 Enter a variety of actions for the program. These actions are now recorded. The Export Data 
dialog lists the actions, frames, and fields being recorded.
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Saving and Browsing Drafts

The Save as Draft and Browse Drafts options are available for component-based programs only 
and must be enabled in Change System Settings. When Save as Draft is enabled, you can save 
selected records without completing all the validations required to ensure that the record is 
complete. You can then finish adding data to the record at a later time by using the Browse Drafts 
option to find the incomplete record. Only the following subset of components provides the ability 
to save unfinished records as drafts to be completed and approved later. 

• Banking Entry
• Business Relation
• Petty Cash
• Customer
• Customer Invoice
• Finance Charge
• Journal Entry
• Supplier Invoice
• Supplier
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Summary
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Chapter Summary
In this section you learned about program types 
and menu features for both component and 
non-component programs.
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Exercise and Knowledge Check

1 Sales Order Control is an example of what type of program?

2 In Sales Order Maintenance, select the GoTo function. Add a link to the Sales Order Browse 
program sobr009.p.
Open up a sales order and GoTo the Sales Order Browse.

3 Display a completed sales order in Sales Order maintenance and send the sales order to your 
User ID by using the workflow. 

4 Create a document in MS Word. Save it to the c:\ drive and attach the document to a purchase 
order. 

5 Select GL Account List, run the report, and send the output to a printer.
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Browses in the QAD .NET UI
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Objective
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Chapter Objectives
The objective of this chapter is to introduce 
browses in the QAD .NET UI. 
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Benefits
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Chapter Benefits
You will be familiar with the different types of 
browses in the QAD .NET UI.
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Training Flow
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Training Flow

Introduction
Navigation
Application Help
Program Types
Browses
Character Version 
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Introduction to Browses in the QAD .NET UI
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Introduction
Browse Topics 
– Look-up Browse
– Power Browses
– Filters and Operators
– Component-based browses
– Favorites
– Grouping
– Column Options
– Managing Filter Fields
– Browse reports
– Quick Search
– Operational Metrics
– Excel Integration and Browse Excel output
– Using the Chart Designer
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Lookup Browse

Return the value selected to the active field in a calling program. The lookup browse has limited 
functionality. Look-up browses cannot filter, graph, or print data

In the example, when you select the lookup Sold-To in Sales Order maintenance, you launch a 
lookup browse of Customer master. 
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Power Browse

A power browse can filter, sort, print, and graph data. Any column can be sorted. The first ten 
columns can be filtered. 

Navigation

• Use the navigation buttons in the top left (1) to move through the records. The buttons from 
left to right move to the first set, previous set, next set, last set. 

• Use the Records per page drop-down to determine how many records display at one time in 
the browse. The default value can be set using the Rows Per Page setting in Tools|Options.

• The Max Browse Records field in User Options Maintenance does not apply to browses in the 
QAD .NET UI. Use Tools|Options in the .NET UI.

• Attempting to display a large number of records at once can adversely affect performance. 
Instead, use the Search conditions to focus on the specific records you want to review.

• Drag columns by their headings to rearrange the display.
• As a shortcut, instead of clicking Edit, you can double-click on the row that includes the item. 

Sorting

• Click Clear All to clear browse results.
• Any column in the title bar can be sorted. 
• Click the heading to sort ascending order; click again to sort in descending order.
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• Columns that cannot be sorted are generally non-indexed fields. Sorting by such fields 
degrades system performance.

• Blue underlined text indicates values for which you can drill-down. 
• Use Browse Maintenance to set the default sort order for the multiple sort orders for the 

multiple columns in a browse
• Right-click any value to display associated links: either a more detailed browse, a related 

program, or an external Web page.

Actions

By selecting the Action menu (2), you can export the browse to .CSV, Excel , PDF or a report. In 
addition you can email the browse or include it in a workflow.
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Filters and Operators

1 Filtering. If stored search criteria exist, you can select one by name from the drop-down list at 
the top of the search criteria (1). This sets up the filter criteria (2) to produce preconfigured 
results. Otherwise, the search fields display with a default configuration. Refine the search 
using combinations of filters and wild cards (*, and ‘.’ for Financials browses). Click the + and 
X buttons (3) to add and remove search filters.Click Clear All to clear the browse results. 

2 Search Operators. The various operators includes equals, not equals, contains, range, starts at, 
greater then, less than, is null, and is not null. When an equal sign is displayed next to the field, 
you enter an exact matching value. 

3 To refine your search further, click the plus (+) icon to add another search row. You can add as 
many rows as needed, each with different search values and operators. If you choose the range 
search operator, the second search box is enabled for the ending value of the range.
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Component-Based Browse

Component-Based Browses

Component-based browses are launched when you view, modify, or delete a record created with a 
component-based activity. For example, Supplier Invoice View (28.1.1.3), Supplier Invoice 
Modify (28.1.1.2), and Supplier Invoice Delete (28.1.1.9) all launch browses, in which you select 
the record on which you want to perform the activity.
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Component-Based Browse
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Browses as Favorites

Saving to Favorites

Click the Add to Favorites button. The browse is saved to your Favorites area and named based on 
the name of the browse. If it is the first instance you have saved, the browse name in the Favorites 
area is the name of the browse. If you save the same browse again, a (2) is appended to the name in 
the Favorites area. Once you have saved the browse to the Favorites pane, you can rename the 
browse and organize it in the same way as other items saved in the Favorites pane.
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Re-Naming Favorites

Re-Naming a Browse

1 Right-click the browse.

2 Click on Rename.

3 Rename the browse.
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Grouping

Right-click and select Group to group data by column type. The grid displays a summary of the 
column data, with the different elements sorted into groups. Each group in the list can be expanded 
using the plus sign next to the group.

Add other columns to the grid to create a group hierarchy. Group options are saved automatically 
in your last used settings, and can be reused when you open this browse again. You can also save 
these options as a stored search.

To remove the split, select the bar icon in the second panel and drag it back to its original position.
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Summarizing Results

The Summary right-click option lets you display summary information, depending on the column 
header in which you have clicked. 

You must be able to view all the records on the screen page to enable the Summary option. If there 
are more records than can be displayed, set the Records per Page field to All.

By right-clicking the BC Amount column in the results grid for Supplier Invoice Browse, you can 
display the following summary information:

Sum. Displays a total sum of the invoice amounts

Count. Displays the number of invoice records

Average. Displays the average of the invoice amounts.

Minimum. Displays the lowest invoice amount.

Maximum. Displays the maximum invoice amount. 

Note   You only see meaningful results if the operator you choose applies to the data type. For 
example, applying the average operator to a date column does not produce a meaningful result. 

Minimum and maximum are useful with dates, and summary and average with numeric fields.
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Column Options

1 Change the column order by clicking the column header in the browse screen and dragging it 
to another position in the results list.

2 Adjust the column size by clicking on the border of the column header and dragging that 
border to the left or the right.

3 Click the column header to sort all data in the result list on any of the columns. Click the 
header again to sort the data in reverse order. 

4 Each column header also features a drop-down filter option when all data has been retrieved. 
Click the icon to display the available filters
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Managing Filter Fields

This option displays all the search fields possible for this type of record. You can use the Manage 
Filter Fields tab to:

• Specify whether a filter field should appear on the Selection Criteria tab (Visible column).
• Specify in which order the filter fields should appear. 
• Specify what operator to use when finding data to view.
• Define a persistent initial value or range of values for the filter field. The values for search 

criteria entered in the actual Search Panel are not saved with the stored search. However, the 
initial values entered in Manage Filter Fields are saved. 

• You can refine the default search for GL accounts to retrieve only accounts with codes that are 
within a number range of 1000 to 5000. 
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Managing Filter Fields
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Actions Menu for Browses

The Actions menu for Browses includes the options to Export to CSV, Excel, or PDF, and 
to generate a report from the browse results.
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Quick Search

Search for a value across all of the fields in the browse. 

Use the *Search For option from the Search pull-down list to retrieve all the results that contain the 
search value in any of the columns. You can use this filter for all browses.Use the Contains, Starts 
With, or Equals operators with the Search For filter. This option searches integers and text strings 
only and does not retrieve dates. Available on the left-hand side of the panel

Create groups of browses for quick search purposes. By default, the browse groups area of the 
panel is empty. Create a new browse group by right-clicking on the panel and selecting New to 
create a new browse folder. Add individual browses or browse collections by selecting the folder 
and dragging and dropping browses from the Applications panel. Enter a search term in the Quick 
Search field and press Enter to search the browses contained in the folder for the term. 
Performance is affected when the browses have many fields with underlying joins.
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Operational Metrics

The Browse Operational Metrics option lets you create a visible metric from browse data. 
Operational metrics provide you with a live snapshot of production data, which lets you monitor in 
real-time how the system is being used. You can use operational metrics to visually track any type 
of browse data, including data from customized browses created in Browse Maintenance. xcel 
Integration

There are a number of pre-defined metrics that can be accessed under the Metrics folder. In this 
case, the Accounts Receivable metric displays different customer metric results. 
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Creating an Operational Metric

• Select Create Metric Collection from the Administration menu to create the initial metric 
collection. The system prompts you to name the collection.

• Right-click the collection title, or select Edit|Create Metric Group to create a metric group for 
the collection. You are prompted to select the parent browse for the group. Double-click the 
name of the browse to select it.
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Create Metric Collection
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Creating a Metric Group

Enter a name for the metric group (for example, Customers by Site) and click OK. Select a browse 
on which to base the first metric.
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Edit, Create Metric Group
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Creating an Operational Metric

Title. Enter a title for the metric (for example, Customers at site 10000).

Type. The default type is Count. When you select the Count type, the browse filter drop-down 
is unavailable. Type options depend on the type of browse. For browses that produce 
numerical values as results, you can also choose Sum, Average, Maximum, or Minimum as the 
Type option. When you select a type other than Count, you can then select the value to which 
you apply the type. 

Percent/Range. Select Percent to display the metric as a percentage of the browse total.Select 
Range to display the metric as a range of figures. This option lets you increase the granularity 
of the results. 

Search. Select the browse filter, operator, and value to define the metric. For example, this 
metric is based on the number of customers in Customer browse whose site code equals 
10000. You therefore select the site code filter to equal 10000. You can set multiple filters for 
the metric, as you do on a normal browse. Click Search to find out how many sites meet the 
criteria (in this case, the number is 33). This information is displayed as a percentage of the 
total (when you have selected the Percent display option). Use the slider controls on the 
percentage bar to set the color code for thresholds.
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Editing Operational Metrics

You can edit metric details by right-clicking the metric name on the main screen and selecting 
Edit. Click on the Save button to save the operational metric to the Metrics folder, New to save the 
metric for the first time, and Replace to replace an existing metric.The metric is now available in 
the Metrics folder. You can add operational metrics to Favorites. To refresh the metric information, 
re-run the individual browses from within their metrics.
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Creating Excel Output From Browses

Click the Actions Tab and Export to Excel button.

The export creates three worksheets in an Excel workbook, which is opened for display.
• Data. This page contains the actual data columns and headings from the printed browse.
• Search Conditions.This page displays any search conditions used to filter the printed data. The 

conditions listed are field name, operator, value, and, for a range operation, the ending value.
• Info. This page lists details about the report generation including the ID of the user generating 

the report, the date the report was generated, the name of the browse, and the browse program.
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Excel Integration

Excel integration is a utility for component-based programs that lets you export data into Excel 
spreadsheets, create new data within Excel, and import it to the system database, where it is 
validated before being saved.

Note   The more advanced bi-directional Excel integration is supported in only a subset of 
components.

This activity has multiple steps:
• Choose the Excel Integration activity such as Country Excel Integration.
• Load data into the grid using the Load option (right-click the empty grid to select Load). The 

Load option lets you retrieve all database records for a supported business component.
• Export the data to a spreadsheet, open the data in Excel, and modify it (right-click the grid 

again to select Export to Excel).
• Save the Excel file in a folder that can be accessed so that the Excel sheet can be modified.
• Modify the Excel file and save for import. Right click on the maintenance screen and select 

Import From Excel.
• Import the modified data (right-click the empty grid to select Import from Excel, and click 

Save to create or update the data in the system database).
• Notice the changes that were made. 
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Excel Integration
Loading Data for Export to Excel for Maintenance
– The Load option lets you retrieve all the records from the 

database and export them to Excel for maintenance. 
– Choose the Excel Integration activity from the menu and load 

data into the grid using the Load option (right-click the empty 
grid to select Load).

– Export the data to a spreadsheet, open the data in Excel, and 
modify it.

– Right-click the grid again to select Export to Excel.
– Save your changes. 
– Import the modified data (right-click the empty grid to select 

Import from Excel, and click Save to create or update the data 
in the system database). 
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Chart Designer

Generate graphical representations of browse data.

Toggle between the standard browse display (called the grid view) and the new chart view.

Use the chart view editor to select data in a browse and display the data as a pie chart or bar graph, 
for example.
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Chart Designer
Generate graphical representations of browse data.
Toggle between the standard browse display (called 
the grid view) and the new chart view.
Use the chart view editor to select data in a browse 
and display the data as a pie chart or bar graph, for 
example.
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Using The Chart Designer
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Creating Charts from Browses
1. Start a browse and click on the Chart 

Designer icon. 
2. Design a chart using the Browse Chart 

Designer.
– Set X- and Y-Axis

labels
– Set X and Y variables
– Group By X Values
– Chart Title
– Chart Type
– Preview
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Chart Options
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Chart Options
Rotate and Zoom 3D Charts
Search Charts
Hide Titles and Legends
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Chart Options
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Chart Options
Launch Chart in New Window.
Copy Chart to Clipboard
Edit Chart Design 
Interactive Charting
– For any item that has a drill-down, a split-screen 

view of both the chart and the drill-down browse, 
which can also be displayed as a chart.

– Click an item in the first chart, to automatically 
change the view to reflect the changed data for the 
drill-down. Click an item in the chart to select the 
associated row in the browse. Conversely, click a row 
in a browse to select the associated item in the chart
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Summary
es
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Summary
Browses let you to display selected data in 
different formats. You can also display browse 
data as charts or as operational metrics. 
Operational metrics can be used to display  
operational deficiencies in real time.
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Exercise and Knowledge Check

1 Open up the Sales Order Browse. Highlight any Sales Order and drill down by double-clicking 
a Sales Order number. In the Sales Order Maintenance screen that appears, click the Sold-To 
lookup.

2 Go to Supplier Invoice View and display a component-based browse.

3 Use Sales Order Browse and limit the output of the Sales Order Browse to orders for one 
specific customer.
What was the filter did you use? What operator did you use? Send the output to an Excel sheet.

4 From the Metrics folder, display the Accounts Receivable metric. 

5 Run Excel Integration for Country Browse. Delete a country and re-import the Excel sheet.

6 Run Sales Order Browse and rearrange the columns. Group the results by Sold-To.

7 Use Chart Designer to create a chart for Item Master Browse. 
Label the x axis Product Line and select the variable prod line.
Label the y axis label Part Number and select the variable item number and group by count.
Select a 3D pie chart and run the chart. 
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